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Chapter 1

PowerPoint in a Nutshell
IN THIS CHAPTER

� Why use PowerPoint?

� The PowerPoint interface

� Working with views

� Controlling the display

� Using content placeholders

� Selecting and manipulating slides

� Managing presentation files

NEW TO POWERPOINT? Start here. Before diving head-first into some of the more
advanced topics in the rest of the book, let’s spend a few pages reviewing some of
the basic ‘‘must-knows” about the application.

Why Use PowerPoint?
I was talking to a new acquaintance recently at a party who had just discovered
PowerPoint. As a graphic artist back in the 1980s for one of the ‘‘big three” TV
networks, she had spent many years creating presentation graphics and overlays
for commercials and TV shows. She was so excited about PowerPoint’s capabilities!
‘‘With PowerPoint, I can do in 2 minutes by myself what it would take a staff of
20 people a whole week to do,” she told me.

That’s PowerPoint’s appeal, in a nutshell. It does all these amazing graphical
things that make presentation graphics really shine, and it does them so easily and
quickly that it puts the power of creation in almost anyone’s hands.

PowerPoint is a very popular tool among people who give presentations as part of
their jobs, as well as for their support staff. With PowerPoint, you can create visual
aids that will help get the message across to an audience, whatever that message
may be and whatever format it may be presented in. The following are just a few of
the types of presentations you can have:

� Speaker-led: The most traditional kind of presentation is a live speech
presented at a podium. For live presentations, you can use PowerPoint to 3
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4 Part I: The Big Picture Design

create overhead transparencies, 35 mm slides, or computer-based shows
that can help the lecturer emphasize key points.

� Self-running: Over the last several years, advances in technology have
made it possible to give several other kinds of presentations, and
PowerPoint has kept pace nicely. You can use PowerPoint to create kiosk
shows, for example, which are self-running presentations that provide
information in an unattended location. You have probably seen such
presentations listing meeting times and rooms in hotel lobbies and giving
sales presentations at trade show booths.

� Internet: The Internet has also made several other presentation formats
possible. You can use PowerPoint to create a show that you can store on a
Web or intranet server so that people can watch it at their own leisure from
anywhere in the world.

Can you create presentation support materials without PowerPoint? Certainly.
You could make a Word document where each page was a ‘‘slide,” or you could
create a Web-based presentation with Web page creation software like Microsoft
FrontPage or Macromedia Dreamweaver, for example. But it wouldn’t be nearly as
easy as it is with PowerPoint, and the results would probably not be as professional.
PowerPoint is somewhat of a one-trick pony in the business software arena. It does
one thing really well: make presentation materials.

PowerPoint 2003 is a member of the Microsoft Office 2003 suite of programs. A

suite is a group of programs designed by a single manufacturer to work well to-

gether. Like its siblings Word (the word processor), Excel (the spreadsheet), Out-

look (the personal organizer and e-mail manager), and Access (the database),

PowerPoint has a well-defined role in the family. Because PowerPoint is so tightly

integrated with the other Microsoft Office 2003 components, you can easily

share information among them. For example, if you have created a graph in Excel,

you can use that graph on a PowerPoint slide. It goes the other way too. You can,

for example, take the handouts from your PowerPoint presentation and export

them to Word, where you can dress them up with Word’s powerful document

formatting commands. Virtually any piece of data in any Office program can be

linked to any other Office program, so you never have to worry about your data

being in the wrong format.

The PowerPoint Interface
PowerPoint is a fairly typical Windows-based program in many ways. It contains
the same basic elements that you expect to see: title bar, menu bar, window controls,
and so on. And like all Office 2003 applications, it has a task pane that provides
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shortcuts for common activities. Here’s a quick rundown of some basic elements,
which are shown in Figure 1-1.

� Toolbars: The Standard and Formatting toolbars appear at the top, and the
Drawing toolbar at the bottom, by default. Other toolbars come and go
automatically as needed, and they can also be displayed or hidden by
right-clicking any visible toolbar and choosing from the menu
that appears.

� Task pane: This pane pops up on its own for certain activities as well as
when PowerPoint starts. You can also display or hide it manually from the
View menu.

� Slide pane: This is where the PowerPoint slide(s) that you are working on
appear.

� View buttons: Near the bottom left corner of the screen are some tiny icons
for switching back and forth between the various views. (More on views
shortly.)

� Tabs: In Normal view (which is shown in Figure 1-1), the left-hand pane
has two tabs: Outline and Slides. (In this book I refer to that pane as the
Outline/Slides pane.) Each shows a different view of the list of slides in the
presentation.

Standard and formatting toolbarsTabs for Outline /Slides pane

we

Task pane

Slide paneDrawing toolbar
View buttons

Figure 1-1: Parts of the default PowerPoint display.
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If you have only a single row of toolbar buttons at the top of your screen, the

Standard and Formatting toolbars are probably all bunched up on a single row

together. That’s the default for PowerPoint (unfortunately, in my opinion). To

place them on two separate rows, choose Tools Customize, and on the Options

tab, mark the Show Standard and Formatting toolbars on two rows checkbox.

Another default setting you will probably want to change before going much

further is to turn off the Personalized Menus feature. It’s the one that hides some

of the menu commands when you first open menus. To turn that off, choose

Tools Customize again, and on the Options tab, mark the Always show full menus

checkbox.

Working with Views
A view is a way of displaying your presentation on-screen. PowerPoint comes with
several views because at different times during the creation process, it is helpful
to look at the presentation in different ways. For example, when you are adding
a graphic to a slide, you will want to be able to work closely with that individual
slide, but when you need to rearrange the slide order, you will want to see the entire
presentation as a whole.

PowerPoint offers the following views:

� Normal: This is a combination of several resizable panes, so you can see
the presentation in multiple ways at once. Normal is the default view and
was shown in Figure 1-1. Each of the panes in Normal view has its own
scroll bar, so you can move around in the outline, the slide, and the Notes
panes independently of the other panes.

� Slide Sorter: This is a light-table type overhead view of all the slides in
your presentation, laid out in rows, suitable for big-picture rearranging
(see Figure 1-2).

Here’s a funny little quirk. Even if you choose to show the Standard and For-

matting toolbars on two rows, the two toolbars in Slide Sorter view will still ap-

pear on a single row by default. In Slide Sorter view, the toolbars at the top are

Standard and Slide Sorter. To make them appear on two rows as shown in

Figure 1-2, drag the Slide Sorter toolbar down below the Standard toolbar by

dragging its ”handle”---that is, the vertical row of dots at its left end.

� Notes Page: This is a view with the slide at the top of the page and a text
box below it for typed notes to yourself. (You can print these notes pages
to use during your speech.) See Figure 1-3.
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Standard toolbar

Slide Sorter toolbar

Figure 1-2: The Slide Sorter view.

Notes

Figure 1-3: The Notes Page view.
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� Slide Show: This is the view you use to show the presentation to an
audience on a computer screen. Each slide fills the entire screen in its turn.

In some earlier versions of PowerPoint there were also Outline and Slide views,
but these have been combined into Normal view. The tabs in the Outline/Slides
pane in the Normal view switch back and forth between viewing the presentation’s
text outline and viewing thumbnail images of the slides, and these serve the same
purpose as those older views did. You can resize the space allocation among the
panes by dragging the borders between them.

There are two ways to change the view: open the View menu and select a view,
or click one of the View buttons in the bottom left corner of the screen, as pointed
out in Figure 1-1. All of the views are available in both places except Notes Page;
it can be accessed only from the View menu.

Controlling the Display
As with anything, it’s easier to work with PowerPoint when you can clearly see what
you’re doing. Here are some tips for making the display show the elements you want
to see.

Customizing the Normal View Panes
In Normal view, you can adjust the sizes of the panes relative to one another by
dragging the borders between them. To get rid of one of the panes entirely, drag
the border between it and the adjacent pane so that it is as small as possible. For
example, in Figure 1-4 I’ve dragged the bar between the Slide pane and the Notes
pane down all the way to the bottom, so the Notes pane is completely hidden, and
I’ve increased the width of the Outline tab’s section. The Outline/Slides pane also
has an X in its top-right corner that you can click to close it.

To restore any panes you’ve hidden, reselect Normal view from the View menu.
This does not restore the sizes of any panes you resized, nor does it reopen the task
pane. (Choose View-Task Pane to do that.)

Setting the Zoom
If you need a closer look at your presentation, you can zoom the view in or out
to accommodate almost any situation. For example, if you have trouble placing a
graphic exactly at the same vertical level as some text in a box adjacent to it, you
might zoom in for more precision. You can view your work at various magnifications
on-screen without changing the size of the surrounding tools or the size of the print
on the printout.

In a single-pane view like Notes Page or Slide Sorter, a single zoom setting affects
the entire work area. In Normal view, each of the panes has its own individual zoom.
To set the zoom for the Outline/Slides pane only, for example, select that pane first
by clicking inside it, and then choose a zoom level. Or to zoom only in the slide
pane, click it first.
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Drag border

Notes pane hidden

Figure 1-4: You can customize Normal view by dragging the dividers between panes.

Instead of clicking a pane in the Normal view to switch to it, you can press F6

to move clockwise among the panes or Shift+F6 to move counterclockwise. You

can also use Ctrl+Shift+Tab to switch between the Slides and Outline tabs of the

Outline/Slides pane.

The easiest way to set the zoom level is to open the Zoom drop-down list on the
Standard toolbar and choose a new level, as shown in Figure 1-5. You can also type

Figure 1-5: Choose a zoom percentage from the Zoom drop-down list.
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a specific zoom percentage into that box; you aren’t limited to the choices on the
list. (However, some panes do limit you to 100% as the highest zoom level.)

The default zoom setting for the Slide pane (Normal view) is Fit, which means
the zoom dynamically adjusts so that the entire slide fits in the Slide pane and is
as large as possible. If you drag the dividers between the panes to redistribute the
screen space, the size of the slide in the Slide pane adjusts too, so that you continue
to see the whole slide. You can change the zoom to whatever you like and then
return to the default by choosing Fit as the zoom amount.

The larger the zoom number, the larger things appear on-screen. A zoom of 10%
would make the slide so tiny you couldn’t read it. A zoom of 400% would make
the slide so big that a few letters on a slide would fill the entire pane. The main
advantage to zooming out is to fit more on the screen at once. For example, if
you’re working with a lot of slides in Slide Sorter view and normally can see three
slides per row, zooming out to 33% might let you see eight or more slides on each
row. The disadvantage, of course, is that if the slides get too small, as shown in
Figure 1-6, you can’t read the text or tell the slides apart from each other.

Figure 1-6: Zooming out lets you see more at once, but at the cost of readability.

Another way to control the zoom is with the Zoom dialog box. Select View-Zoom
to open it. Make your selection, as shown in Figure 1-7, by clicking the appropriate
button, and then click OK. Notice that you can type a precise zoom percentage in
the Percent text box. This is the same as typing a percentage directly into the Zoom
text box on the Standard toolbar.
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Figure 1-7: You can control the zoom with this Zoom
dialog box rather than the list on the toolbar, if you prefer.

Displaying and Hiding Screen Elements
PowerPoint has a lot of optional screen elements that you may (or may not) find
useful, depending on what you’re up to at the moment. In the following sections I’ll
show you the most common ones and explain how to toggle them on and off.

RULERS
Vertical and horizontal rules around the Slide pane can help you place objects more
precisely. The rulers aren’t displayed by default, however; you have to turn them
on. To do so, select View-Ruler. Do the same thing again to turn them off. Rulers
are available only in Normal and Notes Page views.

Rulers help with positioning no matter what content type you are working with,
but when you’re editing text in a text frame, they have an additional purpose as
well. The horizontal ruler shows the frame’s paragraph indents, and you can drag
the indent markers on the ruler just like in Word (see Figure 1-8). Control those
indents more precisely by holding the Ctrl key while dragging them.

Notice in Figure 1-8 that the rulers start with 0 as the spot in the top-left corner of
the selected frame, and they run down to the right from there. When an object other
than a text frame is selected, or when no object is selected at all, the ruler’s num-
bering changes. It starts with 0 at the center of the slide vertically and horizontally
and runs out in both directions from those midpoints.

GRID AND GUIDES
Guides are on-screen dotted lines that can help you line up objects on a slide. For
example, if you want to center some text exactly in the middle of the slide, you can
place the object exactly at the intersection of the guide lines. With the ruler alone
you would have to eyeball it, but with the guides you can be very precise. Guides
are available in the same views as rulers: Normal and Notes Pages. Figure 1-9 shows
one vertical and one horizontal guide line.
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Vertical ruler Indent markers Horizontal ruler

Figure 1-8: Rulers can help you place objects precisely and can also help set and
change paragraph indents in a text frame.

Guides

Figure 1-9: Guides help you position objects precisely.
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The grid is a group of evenly spaced lines like those on a piece of graph paper.
When you drag objects around on a slide, they snap to this grid automatically, to
help you get things aligned with one another. The Snap feature is on by default,
although, by default, the grid’s lines are invisible.

The settings for both guides and the grid are controlled from the Grid and Guides
dialog box. Choose View-Grid and Guide (or press Ctrl+G) and then use the settings
there to turn the features on/off and change their settings (see Figure 1-10).

Figure 1-10: Adjust grid and guide settings in this dialog box.

A shortcut for displaying or hiding guides is to press Alt+F9. To use more guides

than just the default two, hold down Ctrl as you drag one of the guide lines; a

duplicate will be created of it, up to eight in total in either direction.

DISPLAYING OR HIDING COLORS
Most of the time you will work with your presentation in color, but if you are even-
tually going to present the presentation in black and white or grayscale (for example,
on overhead transparencies or black-and-white handouts), you might want to check
to see what it will look like without color. To do so, choose View-Color/Grayscale
and then choose Color, Grayscale, or Pure Black and White.

This Pure Black and White option is especially useful when you are preparing

slides that will eventually be faxed, because most fax machines fax only in pure

black and white. Something that looks great on a color screen could look like a

shapeless blob on a black-and-white fax.
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When you choose Grayscale or Pure Black and White, a Grayscale View toolbar
appears. From it you can open a drop-down list of various types of grayscale and
black-and-white settings. Select an object, and then choose the setting that shows
the selected object to best advantage; PowerPoint will remember that setting when
printing or outputting the presentation to a grayscale or black-and-white source
(see Figure 1-11). When you are finished, click the Close Grayscale View button on
the Grayscale View toolbar, or choose View-Color/Grayscale-Color. Changing the
Black and White or Grayscale settings doesn’t affect the colors on the slides; it only
affects how the slides will look and print in black and white or grayscale.

Choose a setting Selected object

Figure 1-11: Select a grayscale or black-and-white option for individual objects.

DISPLAYING OR HIDING THE TASK PANE
The task pane is a separate pane that sometimes appears to the right of the other
PowerPoint panes. Its content depends on the activity you are performing. Many
activities that used to be contained in dialog boxes in earlier versions of PowerPoint
are now accessed from the task pane instead, such as changing the design template
and the slide layout.

To display the task pane, choose View-Task Pane or choose a command that
requires it to be open (such as Format-Slide Layout). To hide the task pane, click the
Close (X) button in its upper-right corner.
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Once the task pane is open, you can switch among all the available task pane
pages by opening its menu. As you can see in Figure 1-12, there are many task
pane pages, and just like with any other panes in PowerPoint, you can resize the
task pane to take up more or less space on-screen; just drag its border.

Click here to open the menu

Figure 1-12: Switch among the different task pane pages from the menu at the top.

The Getting Started task pane opens automatically each time you start Power-

Point. If you want to suppress that, choose Tools Options and on the View tab,

deselect the Startup Task Pane checkbox. While you’re there, check out some of

the other viewing options you can control there, such as whether or not to show

the status bar and vertical ruler.

Using Content Placeholders
Slides are based on layouts. The default layout for the first slide in the presentation
is Title; the default layout for all subsequent slides is Title and Text.
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You’ll learn more about layouts in Chapter 3; I’m bringing them up now only
because the layout controls the type and positioning of the content placeholders
on the slides. Whenever you see a dotted-line box with something in it like ‘‘Click
to add . . .” something, that’s a text placeholder. There are other kinds of content
placeholders too, such as placeholders for graphics, charts, tables, and so on.

Text Placeholders
To use a text placeholder, just click in it and type the text. Anything you type
in them will appear on the Outline tab, and vice versa. (That is, anything you type
on the Outline tab will show up on a slide in a text placeholder.) When you delete all
the text from a text placeholder, the default message ‘‘Click here . . .” returns. (The
placeholder text does not appear in Slide Show view.)

Text placeholders have an AutoFit feature that’s enabled by default. If you type
more text in a placeholder box than will fit, PowerPoint will automatically decrease
the size of the text and change the line spacing so that it will all fit. If you then
delete some of the text later, it will reenlarge the text.

For a text placeholder that has been AutoFitted, an AutoFit icon appears in the
bottom left corner. You can click that icon to change the AutoFit behavior (see
Figure 1-13).

AutoFit icon

Figure 1-13: Click the AutoFit icon to control the AutoFit setting of a text placeholder.
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A text placeholder box is not the only kind of text box you can have on a slide.
You can also manually add a text box using the Text Box tool on the Drawing
toolbar. The text in such a text box does not appear on the outline.

Chapter 5 discusses the pros and cons of using text placeholders versus manual

text boxes.

Graphic Object Placeholders
Some slide layouts have placeholders for graphic objects. Of these, some have a
placeholder for one specific type of graphic, such as clip art, while others have a
grid of six icons and enable you to insert any of the six different object types.
Figure 1-14 shows one of these multi-purpose placeholders.

To use the graphic placeholder shown in Figure 1-14, you would click one of the
six icons. From there, a task pane or a dialog box appears asking for the specifica-
tions or settings for that object. Just follow the prompts.

Table
Graph

Clip art

Picture from file Diagram
Sound or video

Figure 1-14: Some layouts have a multi-purpose graphic
object placeholder like this one.

You can also place graphics of all kinds on a slide manually, independent of
any placeholder. You’ll learn those techniques in Part III of the book. When you do
manually insert a graphic on a slide, PowerPoint’s AutoLayout feature tries to be
helpful by changing the slide’s layout to one that includes a placeholder for that
type of graphic, and placing the manually inserted graphic into that placeholder.
If that’s what you want, great. If not, you can reverse the action by clicking the
AutoLayout icon (which shows up automatically in the bottom-right corner of the
inserted object) and choosing Undo Automatic Layout, as shown in Figure 1-15.

Adding and Deleting Slides
You can type slide text in the Outline pane to add new slides to the presentation.
To promote a line of text to be its own slide, press Shift+Tab; to indent text to be
subordinate to the text above it, press Tab. All new slides added using this method
have the default Title and Text layout.
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AutoLayout icon

Figure 1-15: You can undo an AutoLayout, if desired.

Chapter 4 discusses text manipulation in the Outline pane in more detail.

You can also add new slides with the New Slide button on the Formatting toolbar.
Clicking this button opens the Slide Layout task pane, from which you can select
any layout desired (see Figure 1-16).

To delete a slide, display or select the slide and then choose Edit-Delete Slide.
(There are other methods too; you can select it in the Slides pane or in Slide Sorter
view, and press the Delete key on the keyboard, for example. You can also right-click
it and choose Delete Slide.)

Selecting Slides
PowerPoint has three broad types of commands: those that operate on a single slide,
those that operate on a selected group of slides, and those that operate on the entire
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New Slide button Slide Layout task paneOutline

Figure 1-16: Add a new slide either by typing in the Outline pane or by clicking the New Slide
button.

presentation file. Most of the single-slide commands, such as a command that inserts
an object on a slide, are executed from Normal view. In Normal view you see only
a single slide at a time, so selecting the slide is not an issue. The selected slide is
simply the one that is displayed.

Most of the ‘‘group of slides” commands, such as deleting, moving, and applying
a transition effect, are best performed in Slide Sorter view. Because you see multiple
slides at a time in that view, you must select the slides you want to affect. (You can
do this from the Slides pane in Normal view too, but it’s a little more awkward.)

Here are the options for selecting slides in Slide Sorter view (or the Slides pane
in Normal view):

� To select a single slide, click it.

� To select multiple slides, hold down the Ctrl key as you click each one. A
selected slide will show a shaded border around it.

� To select a contiguous group of slides, click the first one and then hold
down the Shift key as you click the last one. All the slides in between will
be selected as well.

� To cancel the selection of multiple slides, click anywhere away from the
selected slides.
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Saving Presentation Files
In PowerPoint, the standard operations, such as saving work, are just like in any
other Office application. To save, click the Save button on the Standard toolbar or
choose File-Save. To save the presentation under a different name or location, or as
a different type, use File-Save As. No surprises there.

In most cases you’ll want to save PowerPoint presentation files in the default
format: Presentation (*.ppt). There are lots of alternatives available, though, and
Table 1-1 summarizes them. If you decide you want to save in PowerPoint format,
you have three choices:

� Presentation (PowerPoint 2003) format is very versatile. It is compatible
with all PowerPoint versions 97 and above (97, 2000, 2002, and 2003), and
it preserves all features.

� PowerPoint 97--2003 and 95 format adds compatibility for PowerPoint 95
to the mix, but it also greatly increases the file size. That’s because in 97
and higher, graphics are compressed, but in 95 they are not. Therefore, the
presentations saved in this format must support both. All features are
preserved, although many of them will not be visible in the earlier
PowerPoint versions.

� Presentation for Review format is not an option when you first save the
file, but if you use Save As to save it again, you will have access to it. It’s
almost exactly the same as Presentation format, but it keeps track of
changes made to e-mailed copies so you can merge the changes later. Don’t
use this unless you need to, because the file size grows until you merge the
changes each time someone else’s revisions are added.

Although all of these formats retain all features of PowerPoint 2003, other people
using earlier versions of PowerPoint to view them might not see things exactly the
same as they were created. See Appendix A for a complete analysis of what doesn’t
work in which earlier version.

TABLE 1-1 FORMATS IN WHICH YOU CAN SAVE POWERPOINT SLIDES

Format Extension Notes

Presentations

Presentation PPT The default. Use in most cases. Can be opened in
PowerPoint 97 and higher.

PowerPoint
97-2003 & 95

PPT For use in a variety of earlier versions of PowerPoint,
including PowerPoint 95. Results in a large file because
it contains the uncompressed images needed to support
PowerPoint 95. Retains all PowerPoint 2003 features.
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Format Extension Notes

Single File Web
Page

MHT,
MHTML

Web-based, but all elements in a single file. Suitable for
use as an e-mail attachment. May lose some animation
effects.

Web Page HTM,
HTML

Creates a plain-text HTM file and pulls out each graphic
element in a separate file. Suitable for posting on a Web
site. May lose some animation effects.

Presentation for
Review

PPT Creates a normal PowerPoint file but sets it up to track
revisions from multiple revisers. Not an option when
saving initially.

Design Template POT Creates a template that can be used for formatting
future PowerPoint presentations you create.

PowerPoint Show PPS Just like a normal presentation file except it has a
different extension and opens by default in Slide Show
view instead of Normal view.

Graphics/Others

PowerPoint Add-In PPA Stores any Visual Basic for Applications (VBA) code
associated with the presentation as an add-in.

GIF Graphics
Interchange
Format

GIF Static graphic. GIFs are limited to 256 colors.

PNG Portable
Network Graphics
Format

PNG Static graphic. Similar to GIF except without the color
depth limitation.

JPEG File
Interchange
Format

JPG, JPEG Static graphic. JPEG files can be very small, making
them good for Web use.

Tagged Image File
Format

TIF, TIFF Static graphic. A high-quality file format suitable for
slides with high-resolution photos.

Device
Independent
Bitmap

BMP Static graphic. BMP is the native format for Windows
graphics, including Windows background wallpaper.

Continued
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TABLE 1-1 FORMATS IN WHICH YOU CAN SAVE POWERPOINT SLIDES (Continued)

Format Extension Notes

Windows Metafile WMF Static graphic. A vector-based format, so it can later be
resized without distortion. Not Mac-compatible.

Enhanced
Windows Metafile

EMF Enhanced version of WMF, not compatible with 16-bit
applications. Also vector-based and non-Mac-
compatible.

Outline/RTF RTF Text and text formatting only; excludes all non-text
elements. Only text in slide placeholders will be
converted to the outline. Text in the Notes area and in
manually placed text boxes is not included.

The MultiSave add-in by Shyam Pillai allows you to save a PowerPoint presen-

tation in many formats simultaneously; this can be useful if you need to make

copies in different formats and keep all the copies synchronized. Download it

from http://officeone.mvps.org/multisave/multisave.html.

At that same Web site is a Sequential Save add-in that creates a backup of

the last saved version of a presentation before overwrites it with changes. See

www.mvps.org/skp/seqsave.htm.

Presentation Basics: Some Tips
Before you start diving into the multimedia presentation building in the rest of the
book, you’ll need some basic presentation-building skills. I’m assuming that many
of you already came to this book with those, and I hope that this chapter has helped
the rest of you come up to speed.

Following is some related info I haven’t touched on here that might be useful to
a beginner:

� You’re not completely alone in this presentation-building thing.
PowerPoint comes with lots of templates that give you a jumpstart on a
presentation; see Chapter 2 to learn more about them.

� For almost every type of content, you have a choice of using a layout with
a placeholder or inserting the object manually. It’s usually best to use the
placeholder. See Chapter 3 for more information about layouts.
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� If you find yourself making the same changes to every slide in the
presentation, save yourself some time---use the Slide Master. Anything you
do to the Slide Master automatically trickles down to every slide in the
presentation. Chapter 3 explains the Slide Master.

� PowerPoint may not be your favorite program for text editing, and it need
not be. You can create the presentation text in some other program, like
Word, and then import it into a presentation. See Chapter 4 to learn how to
do that.

� Slide content exists in frames that float over the top of the slide. There are
text frames, graphics frames, and so on. Every framed object can be moved
(drag it by its middle, or by its border but not on a selection handle),
resized (drag it by a selection handle), or deleted (select the frame and press
Delete). Chapter 7 explains manipulating graphics, and the information
there applies to most other types of objects as well.
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